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1   Installing Intacta Express Software 
 

This chapter provides the system requirements and installation instructions for 
the Intacta Express software. 

 
System Requirements 

 
• IBM PC or compatible with 486 processor or higher. 
• Hard disk, with at least 4 Mbytes free disk space for Intacta Express files. 

Optimal performance requires at least 10 Mbytes. 
• At least 16 Mbytes of RAM. 
• Environment: Windows 95 / 98 / NT / 2000 
 
 

 

Installing Intacta Express  

1. Download IntactaExpress.zip into a temporary folder 
2. Unzip IntactaExpress.zip. It should create subfolders ‘disk1’ and ‘disk2’. 

3. Go to subfolder ‘disk1’ and double click on ‘install.exe’ to begin the 
installation 
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2     Intacta Express Introduction 

 

Intacta Express is a windows software application for the transmission and 
reception of computer files. You can send, receive and store any digital files on a 
plain paper in a special coded format.  

The software first compresses and then transforms the data files into a coded 
unintelligible form, called an IntactaCode. 

An IntactaCode is a graphic image representation of digital computer files, 
generated by a proprietary procedure. On paper, an IntactaCode is composed of 
very small black and white squares. The IntactaCode can be received directly 
into a computer through modem connection, or can be received by a fax machine 
and then scanned into a computer. Alternately, it can be printed and sent via a 
fax machine. When the IntactaCode is received, the receiver uses Intacta 
Express’s Decoder to decode the image back into the original file. 

Advantages of Intacta Express software 

Intacta Express software enables you to transfer files using email, fax or in a 
piece of paper. 

• Confidentiality:  IntactaCode is unintelligible to the casual observer and must 
be transformed back into readable form by Intacta Express software. In 
addition, Intacta Express software security is further enhanced when used 
with a password. 

• Shortened Fax Transmission Time: Intacta Express software automatically 
compresses files and generates an IntactaCode that requires a fraction of the 
number of pages of the original file. Up to 150 pages of a text document can 
be transmitted via Intacta Express software on just one single page, thus 
saving costly telephone connection time. 

• Transmission of Color Pictures by Fax: The black and white pattern that is 
the IntactaCode may represent a color picture, which can be retrieved with 
Intacta Express software. 
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How does Intacta Express software work? 

Intacta Express software is comprised of two modules: a Encoder, which 
generates the IntactaCode that represents selected computer files, and a Decoder, 
which retrieves the original files from the IntactaCode.  

The Intacta Express Encoder 

The Encoder lets you select the files to be transmitted and define the recipient of 
this transmission. It compresses the selected files, generates an IntactaCode, and 
then automatically invokes your fax application, email or printer, which 
transmits the IntactaCode to the destination of your choice. 

 

The Intacta Express Decoder 

An IntactaCode can be received as a paper, by fax, or electronically by modem 
connection 
  
• If the IntactaCode is received by a modem, it must be saved or exported into 

a known folder and later to be selected and decoded. Intacta Express Decoder 
also features Intacta Express Guard, which automatically reads all newly 
received Intacta Express IntactaCodes from any fax application and prepares 
them for you to view and/or save. 

• If the IntactaCode is received by a fax machine, the fax printout must first be 
scanned into your computer. 
♦ If the IntactaCode was sent in Medium density format, any standard 

(300/400 dpi) HP scanner or any similar scanner that supports Twain can 
be used. 

• If the IntactaCode was sent in Low density format, it can be scanned by any 
200/300 dpi scanner.  
Alternatively, the IntactaCode fax printout can be sent by your fax machine 
to your computer. In this case, your computer requires a modem and a fax 
application to receive the file.  

 

Once the received IntactaCode is in your computer, the Intacta Express software 
Decoder decodes the original files. 
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3      Intacta Express Encoder  

Intacta Express Send 
The Intacta Express Encoder lets you select the files or scan the images to be 
transmitted and define the recipient of the transmission. The Encoder compresses 
the selected files, generates an IntactaCode, invokes the fax/printer, e-mail or 
save to file application and prepares the IntactaCode. 

To open the Encoder:  
Double-click on the Intacta Express Encoder icon in the Intacta Express 
program group by selecting the Start, Programs, Intacta Express and then Intacta 
Express Professional Send. 

The Intacta Express Encoder opens, as shown below: 

 
 
The Intacta Express Encoder window is divided into four areas: 
• The control panel, contains the IntactaCode Contents, the IntactaCode 

Properties and Fax /printer Application settings. 
• The IntactaCode Settings bar, which enables you to specify the recipient and 

IntactaCode settings for the current transmission. 
• The menu bar, which provides various Intacta Express functions. 
• The tool bar, which provides quick access to the most frequently used Intacta 

Express menu functions - Log, Setup, Comments, Add Secure Page, View and 
Help. 



 

6  

Encoder - Control Panel 
The Encoder control panel is divided into two main areas, the IntactaCode 
Contents area on the left and the IntactaCode settings area on the right - 
IntactaCode properties and Fax/Printer Application. In between these two areas 
are three control buttons. 

IntactaCode Contents Description Area 
The left side of the Encoder window is the IntactaCode Contents description 
area. In this area, various IntactaCode information is displayed, such as: 

IntactaCode Contents: This list box shows the files or images included in the 
generated IntactaCode. The list shows each file’s name, its actual size and its 
compressed size in KB. 
You can sort the files in the list by pressing column headings. 

Total Size: This field shows the total compressed size of the files to be included 
in the IntactaCode. 

IntactaCode Pages: This field shows the number of pages in this IntactaCode. 

Important! We recommend that you always look at this field before sending an IntactaCode 
to make sure that you know how many pages are about to be transmitted. 

Number of Files: This field shows the number of files or images included in the 
IntactaCode. 

IntactaCode Properties Area 
The IntactaCode Properties area shows the IntactaCode settings that you 
selected using the buttons in the IntactaCode Settings bar, or from the Intacta 
Express Settings window accessed from the To... button. Refer to Lesson 1, 
Step 5 in the online Help for more details on the IntactaCode Settings 
parameters.  

Password: Shows whether the recipient of this IntactaCode will need to enter a 
password to read it. 

Density: Specifies the IntactaCode density format: 
 Low (two block format for scanning with a fax machine or modem)  
 Medium to Fax Machine with Smoothing (four block format for fax 

machine or modem)  
 Medium (four block format for fax machine or modem)  
 High (single block format for modem only) 

Note: Single block format is the most efficient format for transmitting to a modem and is the 
default setting. 
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Note: Select  when sending to a fax machine with smoothing. The transmitting fax 
application should be set to High or Fine resolution. 

Correction Level: Specifies the correction level to be used: Standard (for 
normal telephone lines) or Extended (for poor quality telephone lines). This 
option may enable the retrieval of complete files even when an IntactaCode is 
transmitted over poor quality telephone lines. 

The Destination area specifies the destination to which the IntactaCode will be 
sent. This includes Fax/Printer, Save to File or e-mail destinations. 

Encoder - Control Buttons 
The center of the Encoder window contains three buttons: 

Select: This button accesses the Select window in which you select the files to be 
included in the IntactaCode. Refer to Lesson 1, Step 2 in the online Help. 

Scan: This button automatically invokes the twain compatible scanner window. 

Remove: This button enables you to remove a file from the current IntactaCode 
Contents list. Select one or more files in the IntactaCode Contents area, and then 
press this button to remove them. 

Send: This button sends the current IntactaCode to the specified fax/printer 
application  
Note: The fax application or printer that is invoked can be changed by selecting the 
Fax/Printer Application option in the Setup menu. 
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Encoder - IntactaCode Settings Bar 
The IntactaCode Settings bar enables you to specify the recipient and 
IntactaCode settings for your current transmission, directly in the Encoder 
window. 

Add 
Password

Standard
Level of 
Error Correction

Extended 
Level of 
Error Correction

Low
Density

High
Density

Medium 
Density

Opens Recipient
Settings Window

Recipient field

Medium Density
to Fax Machine
with Smoothing  

Encoder - Menu Bar  

The Encoder menu bar provides access to various Intacta Express functions. 

 
Context sensitive menu options and help may be accessed using the right mouse 
button. 
Each menu and its options are described on the following pages. 

File Menu 

 
The File menu provides the following options: 

Open Log 

This option opens the Encoder Log which contains a record of each IntactaCode 
that was sent.  
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The Log file can be used when an IntactaCode block cannot be read by a 
recipient: 
• The sender can resend blocks directly from the Log window without 

regenerating the entire IntactaCode.  
• Alternatively, the sender can reload an event from the Log window into the 

IntactaCode contents box in the Send window. The files can then be 
reorganized and the IntactaCode regenerated using different IntactaCode 
settings parameters. 

Comments 

This option opens a window in which you can write a comment that will appear 
at the beginning of the IntactaCode. 

   
The comments file is automatically sent at the beginning of the IntactaCode. The 
recipient without entering a password can always read this file, even when the 
IntactaCode is password protected. 
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Exit 

This option exits the Intacta Express Encoder. 

Setup Menu 
The Setup menu provides the following options: 

Destination 

This option opens a window from which you can select the fax/printer 
application through which the IntactaCodes will be transmitted. 

Picture Compression 

This option opens a window in which you can set the compression parameters 
that will be used on a color picture that is added to an IntactaCode. This option 
allows the user to select the quality of the image after InfoImaging thus 
decreasing or increasing the number of IntactaCode pages created. 

Note: We recommend using the defaulted maximum compression when sending 
color pictures. 

View Menu 

The View menu provides the following options: 

View File 

This option displays the contents of the selected file. If the file is a picture file 
with a resolution of more than 8 bits per pixel, you can change the picture 
quality.  

 

View As 

Provides options for displaying file names as: Large Icons, Small Icons, in a 
List, or in a list with Details. 
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Help Menu 
The Help menu provides the following options: 

Contents 

This option opens an online Help window that describes Intacta Express 
operation. The information in the Help tool includes the information in this 
user’s guide, as well as a 5-lesson tutorial. Press the light green hotspots in the 
window to navigate to the information you require. 

About 

This option displays information about your Intacta Express version, your user 
name and your software license number 
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4    Intacta Express Decoder 
 

The Intacta Express Decoder facilitates the input of an IntactaCode into your 
computer so that it can be read.  

• When an IntactaCode is received by modem it is read from a disk file.  

• When an IntactaCode is received by your fax machine, it can be scanned into 
your computer, or, when sent in Low density format, it can be sent to your 
computer from your fax machine and then read from a file. 

Intacta Express Decoder decodes the IntactaCode for information describing its 
contents (files), enables you to retrieve and view these files and then saves them 
for future use. 

To open the Decoder: 

Double-click on the Intacta Express Decoder icon in the Intacta Express 
program group. 

 

The appearance of the Intacta Express Decoder differs depending on whether 
you set Intacta Express to read from a disk file or from a scanner. To determine 
the source from which the IntactaCode files are read, disk file or scanner, press 
the Read From tool in the tool bar or select the Read From option in the 
Options menu.  

 
• When an IntactaCode is received by modem, it is automatically detected by 

Intacta Express’s Fax Guard or alternately, read from the disk file into which 
it was exported (or saved) from the fax application.  

• When an IntactaCode is received by fax machine, it can be read by scanner 
or, when sent in Low density format, it can be sent to the computer by the fax 
machine and read from a file. 
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The following shows the Intacta Express Decoder window when Intacta Express 
is set to read from files: 

 

 
 

 

 

The following shows the Intacta Express Decoder window when Intacta Express 
is set to read from an HP compatible scanner. 

 

The Intacta Express Decoder window is divided into three areas: 

• The control panel, through which you work with Intacta Express. This is the 
main body of the window. 

• The menu bar, which provides various Intacta Express functions. 

• The tool bar, which provides quick access to the most frequently used Intacta 
Express menu functions. 
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Decoder - Control Panel 
The Decoder control panel is divided into a number of different areas. Each of 
these areas and the control buttons in the center are described on the following 
pages. 

Read From Files or Read from Scanner 

The top left area of the Read window changes depending on whether you are 
reading from files or from a scanner.  

 

Read from Files 
When reading an IntactaCode from files, the Intacta Express Decoder window 
displays a Read from Files list box showing the files that you have selected 
(using the Select button) to be read. These files will be read after you select them 
in this list and press the Read button. 

 
Intacta Express recognizes the following IntactaCode file formats: bmp, pcx, tiff 
, dcx, awd (Windows 95 version only) or fxs file(s). Therefore, only files with 
these extension names should be selected for this list.  

Read from Scanner 
When reading an IntactaCode from a scanner, the Read window displays a Read 
from Scanner field showing the scanner used.  

Brightness 

The left center of the Intacta Express Decoder window deals with IntactaCode 
brightness. This area has two purposes: 
• To display the brightness of the IntactaCode after it has been read. 
• To adjust the brightness of an HP scanner. 
Note: For Twain compatible scanners, brightness is adjusted in the scanner application. 
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IntactaCode Contents 
This area lists the files that have been retrieved from the IntactaCode. These files 
can be viewed, but they are not saved to your disk until you press the Save 
button. 
Note: Files are retrieved from the IntactaCode when you press the Read button. 

 
The file names appear on the left side of the list. 

The Status column in this list shows the status of each file. It shows one of the 
following: 

• OK if the file was retrieved correctly.  

• Bad if the file was not retrieved correctly. 

• Saved if the file has been saved to disk after reading. 

IntactaCode 
Intacta Express will display the blocks of each IntactaCode page as they are read 
in the top right corner of the Intacta Express Decoder window, in the 
IntactaCode area. 
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When the blocks are first detected, they are displayed in black. Correctly read 
blocks are displayed green after they have been read. Incorrectly read blocks may 
be displayed entirely or partially in the color red. 

This area starts to fill up as an IntactaCode is scanned or as Intacta Express 
Decoders an IntactaCode from a file.  

• Intacta Express starts scanning when you press the Scan button. 

• Intacta Express starts reading an IntactaCode from a file when you press the 
Read button. 

Blocks Status 
The top part of the first block in an IntactaCode specifies how many blocks are 
contained in the IntactaCode. As soon as this part of the IntactaCode is read, 
these blocks are displayed in the Blocks Status area in the bottom right of the 
Intacta Express Decoder window. Each block number appears in a white box 
with a red X.  

As IntactaCode blocks are read into Intacta Express from a scanner or file, 
Intacta Express marks off the blocks that have been read. Blocks that have been 
read correctly are green, bad blocks are red/green and missing blocks remain 
white with a red X. 

Decoder - Control Buttons 

The center of the Decoder window contains the following buttons: 

Scan: This button appears when Intacta Express is set to input files from the 
scanner. Place the IntactaCode page on the scanner, then press this button.  
Cancel: This button is used to abort a scanning process at any stage of the 
process. 
View: This button displays the actual text or image of the file selected in the 
IntactaCode Contents list. The selected file is displayed through the Windows 
associated viewer according to the type (file extension) of the selected file.  
Save: This button extracts the retrieved files from Intacta Express’s internal 
format to the directory of your choice. Always remember, even though an 
IntactaCode’s file list exists and each file can be viewed, the actual files 
represented by the IntactaCode are not saved unless you use this button to save 
the files. If you do not save the files, you will have to extract them from the Log. 
The following buttons are intended for reading an IntactaCode from a file. They do 
not appear in the Intacta Express Decoder window when Intacta Express is set to 
read from a scanner. 
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Select Button: This button enables you to select the files to be read. 
Remove Button: This button enables you to remove a file from the current 
selection in the Read from Files area. Select a file, and then press this button to 
remove it. 
Read Button: This button starts the process of reading the selected IntactaCode 
files. 

Decoder - Menu Bar  
The Decoder menu bar provides access to various Intacta Express functions. 
Each option in the menu bar opens into a pull-down menu. 

Context sensitive menu options and help may be accessed using the right mouse 
button. 

Each menu and its options are described on the following pages. 

File Menu 

The File menu provides the following options: 

Restart  

This option starts a new Read session. When you choose this option, the file 
selection, IntactaCode, its Blocks Status and IntactaCode Contents are all erased 
from the Read window. Use this tool to read a new IntactaCode after a previous 
one was read. 
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Open Log 

This option opens the Decoder Log in which a record of each read IntactaCode is 
saved.  

You can use the Log window to identify the sender and Send log ID of an event 
that has missing or bad blocks. The From column specifies the sender by a 
combination of the sender’s user name and license number. You can then contact 
the sender and request the blocks that are missing, specifying the ID of the 
Encoder Log.  

Report 

This option displays a Notepad window describing the current log event in 
Intacta Express. It contains the same information that can be viewed in the 
Intacta Express Decoder window or through the Log. 

 

Exit 

This option closes the Intacta Express Decoder. 

Options Menu 
The Options menu provides the following option: 

Intacta Express Guard Setup  
This option enables you to set up the Intacta Express Guard Setup option in 
Windows 3.x. 

Note: In Windows 95, this setup is performed through the Microsoft Exchange. See the 
Appendix for details. 
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Once enabled, Intacta Express Guard will check for new faxes each time the 
Decoder is launched or each time you select the Check for New Faxes option 
from the Options menu. 

 

 
 

Intacta Express will check the fax application directories that appear in this 
window’s list box, shown on the previous page.  
!"Perform the following to add fax applications to this list. 

1. Press the Search button to automatically scan your disk for fax applications. 
Those that are found are listed in the window. Intacta Express only searches 
for a pre-defined set of fax applications and therefore it may not find all those 
that are on the disk. Fax applications that are not found must be added 
manually. 

2. Press the New button to add additional fax applications. The following 
window is displayed: 

Name of
the fax

application

Directory in which
the fax application

saves received faxes

File extension
name of 

received faxes

Click here to
browse for a 

fax application
directory

 
Fill in the window as shown above and click OK. 
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Help Menu 
The Help menu provides the following options: 

Contents 

This option opens an online help that describes Intacta Express operation. The 
information in the Help tool includes the same information as in this user’s 
guide, as well as a 5-lesson tutorial. 

About 

This option displays information about your Intacta Express Decoder version. 

Decoder - Tool Bar 
The tool bar provides access to the most frequently used Intacta Express 
functions. 

Restart View
Log

Read
From

HelpReport
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5    Software License Agreement and Limited Warranty 
 

INTACTA EXPRESS SOFTWARE 
INTACTA TECHNOLOGIES, INC. (ITI)  

 

LICENSE AGREEMENT for downloading Color Scan & Fax Reader 
YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND 
CONDITIONS. BY USING THE SOFTWARE PRODUCT YOU 
ACKNOWLEDGE ACCEPTANCE OF THESE TERMS AND CONDITIONS.  

TERMS 
This product including the documentation is licensed solely for your internal use. 
No third party may use the product nor may you use the product on behalf of any 
third party such as in a service bureau type business. You may use the product on 
a single machine. Disassembly and other reverse engineering of the product is 
strictly prohibited.  

 

YOU MAY COPY THE PRODUCT AND PROVIDE COPIES TO OTHERS SO 
LONG AS USE WILL BE LIMITED AS SPECIFIED ABOVE AND THAT ALL 
PROPRIETARY NOTICES ARE REPRODUCED ON EACH COPY.  

 

This License is effective until terminated. You may terminate it at any other time 
by destroying the product and each copy. This license will also terminate if you 
fail to comply with any term or condition.  

WARRANTY 
ITI LICENSES THE PRODUCT "AS IS" AND DOES NOT WARRANT THAT 
THE FUNCTIONS CONTAINED IN THE PRODUCT WILL MEET ANY 
SPECIFIC REQUIREMENTS, THAT THE PRODUCT IS FIT FOR ANY 
PARTICULAR PURPOSE OR THAT THE OPERATION OF THE PRODUCT 
WILL BE UNINTERRUPTED, ERROR FREE OR VIRUS FREE. YOU MUST 
ASSUME FULL RESPONSIBILITY FOR THE SELECTION OF THE 
PRODUCT TO ACHIEVE YOUR INTENDED PURPOSE, FOR THE PROPER 
INSTALLATION AND USE OF THE PRODUCT AND FOR VERIFYING THE 
RESULTS OBTAINED FROM USE OF THE PRODUCT.  
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EXECUTING A DOWNLOADED FILE COULD INITIATE A VIRUS, CAUSE 
THE LOSS OF DATA OR OTHER DAMAGE TO YOUR SYSTEM. YOU DO 
SO AT YOUR OWN RISK. IN NO EVENT WILL ITI BE LIABLE TO YOU 
FOR ANY LOST PROFITS, LOST SAVINGS OR OTHER INCIDENTAL, 
INDIRECT, SPECIAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF 
YOUR USE OR INABILITY TO USE THE PRODUCT EVEN IF ITI HAS 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  

In the event the Federal Acquisition Regulations (FAR) or DFA is applicable to 
this Agreement, the product is provided only with Restricted Rights as defined in 
paragraph 52.227-19 or paragraph 252.227-7013(c)(1)(ii), respectively, as 
applicable.  

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, 
UNDERSTAND IT AND AGREE TO BE BOUND BY ITS TERMS AND 
CONDITIONS. YOU FURTHER AGREE THAT IT IS THE COMPLETE AND 
EXCLUSIVE STATEMENT OF THE AGREEMENT BETWEEN YOU AND ITI 
RELATING TO THE USE OF THE PRODUCT. 
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